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Welcome to Remote Access 
Remote Access enables you to use a PC to access a remote controller. During a Remote 
Access session, the remote controller is displayed, on-line, on your PC screen. You can 
‘press’ keypad keys and touch-screen objects, check system status and run-time values, as 
well as test and troubleshoot problems in remote controllers and applications.  You can 
access: 

 Stand-alone controllers that are directly connected to the PC via a cable. 
 Controllers within a network. 
 Either stand-alone or networked controllers via GSM or landline modem.  
 Devices with IP addresses, via Ethernet. 

Remote Access can be used with either Vision or M90/91 controllers. Vision controllers 
require O/S versions 2.96 and higher; M90/91 require V3.00 and higher. 

 

Using Remote Access 
The Remote Access package includes additional utilities: 

 M90 Downloader 
 Operand Access 
 Data Tables 
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Using Remote Access 

Selecting an OPLC model 
Select the controller model from the Configuration menu. 

 

Note ♦  Vision model controllers: 
Select the model. If the controller is in a network, open Communication-PC Settings from 
the options menu, and select the controller's ID number. 
♦M90/91model controllers within a network: 
Select which type of network, and then select the controller's ID number. 

Communication-PC Settings 
This enables you to check communication parameters and perform certain actions. 

 PC Communication Settings 
 Run, Reset, Initialize 
 Get Com Parameters and PLC status 
 Check Network Status 

 

Remote Access via Modem 
To access either stand-alone or networked controllers via GSM or landline modem: 
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Modems: Setting Up 
PLC-Modem Connection 
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PC Modem Configuration 

Open PC Modem Configuration from the Configuration menu. 
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Online Mode 

Once you have configured Remote Access, enter Online mode by clicking the button . 

In this mode, you can: 

 Use your cursor to operate the controller keypad and activate touch-screen objects 
(relevant models).  

 Use your PC keyboard to operate the controller keypad (numeric keys, function keys 
<F1> to <F8>). Note that the Vision <ESC> key is <E> on the PC keyboard, and that 
<F9> is reserved for activating Online mode. 

 Enter Information Mode by pressing the <i> key with your cursor. 
 Select a View .  

Note ♦ The Zoom option on the View menu can be activated only if you select Hide 
Keys. Zoom cannot be used with M90/91 or V280 controllers. 
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PC Com Parameters (non-modem) 
Display the current communication settings by selecting Communication - PC Settings from 
the Options menu. 

 

Select  
Connect ion  
type  

Use the  d rop-down a r row to  se lec t  se r ia l  o r  E the rne t .  

PC Com 
Parameters  

Po r t ,  Re t r ies  and  T ime-Out  a re  the  commun ica t i on  se t t i ngs  be tween  
Remote  Access  and  the  con t ro l l e r .  No te  tha t  i f  you  a re  work ing  w i th  a  
ne twork ,  the  T imeOut  shou ld  be  g rea ter  than  1  second .  

Communicate 
with OPLC 

Use these  op t ions  to  commun ica te  w i th  ne tworked con t ro l l e rs .   
D i rec t  Connect ion :  se lec t  th i s  to  commun ica te  w i th  any con t ro l l e r  tha t  
i s  connec ted  to  your  PC v ia  the  down load  cab le ,  i nc lud ing  a  ne twork  
b r idge.   
With in  Network : se lec t  th i s  to  communica te  w i th  a  con t ro l l e r  tha t  i s  
i n teg ra ted  in to  a  ne twork ,  then  se lec t  the  con t ro l l e r 's  ID  number  

Vis ion  OPLC 
In format ion  

C l i ck  Get  OPLC In format ion  t o  d i sp lay  in fo rmat ion  abou t  the  con t ro l l e r  
you  have  se lec ted  in  Communicate  w i th  OPLC.  
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Run, Reset, Initialize 
 

 

Note ♦ When you 
click a button, your PC 
will access the 
controller selected in 
PC Communication 
Settings. 

 

Set RTC These  a re  the  va lues  o f  you r  PC 's  c lock .  C l i ck  Set  RTC  t o  impor t  
these  va lues  in to  the  RTC o f  the  con t ro l l e r .  

Get Vision 
RTC Current 
Values 

Cl i ck  to  v iew the  cu r ren t  PLC se t t i ngs  

Run Cl i ck  to  run  the  cu r ren t  p rog ram in  the  PLC.  

Stop Cl i ck  to  s top  the  cu r ren t  PLC p rogram.  

Reset Cl i ck  to  rese t  the  PLC,  and  re ins ta l l  any  va lues  p rese t  i n  the  
p rog ram,  such  as  T imers .  

Reset & 
Initialize 

Cl i ck  to  rese t ,  re ins ta l l  any  p rese t  va lues ,  and  in i t i a l i ze  a l l  
memory  operands   
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Get Com Parameters and PLC status 
 

 

Select Get to view 
communication parameters 
and PLC status in the controller 
you are currently 
communicating with. 

This is the controller selected 
in 
PC Communication Settings. 
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Check Network Status 
The network status is checked via the bridge.  
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Remote Access via Modem 
To access either stand-alone or networked controllers via GSM or landline modem: 

 

Note ♦ The PC-modem cable is not the same type of cable used to connect between the 
controller and the modem. Ensure that the cable used to connect the PC to the modem 
provides connection points for all of the modem's pins. 
     ♦ Both PC and controller must use the same type of modem: either landline or GSM.  
     ♦ Internal modems must be used in conjunction with the driver provided by the modem's 
manufacturer.        
     ♦ If call are routed via a switchboard, note that the switchboard settings may interfere 
with communications. Consult with your switchboard provider.  

Modems: Setting Up 
PLC-Modem Connection 
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PC Modem Configuration 

Open PC Modem Configuration from the Configuration menu. 
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Operand Access 
Operand Access is located on the Tools menu. This utility enables you to access operands 
in a local or remote controller and perform the operations listed below.  

 

 
 

 View remote operands in the Operand Access table, then define and name 
regions. 

To define regions: 

1. Click and drag the cursor over regions to select them. 
2. Click the Add New Region button. 

 
 Save region definitions in .vxt files. 
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In order to open a .vxt file, you must select the controller series (Configure>OPLC 
model, either Vision or M90/91) which was selected when the .vxt file was saved. 

 View real-time operand values in Online mode. 

1. Click the Online icon; real-time values appear in blue. 

 
 

 Read operand values from the controller.  

1. Click the Read icon; all values are read in all of the defined regions. 

efesotomasyon.com -Unitronics Plc



Operand Access 

21 

 
 

 Write MB, MI, ML and DW values to the controller.  

Note ♦ You can also write values to the M90 Database integers. 

1. Enter values, then click write; all of the values in all of the defined regions are 
written to the controller. 

 
 Use the Windows Clipboard to Cut/Copy/Paste values to/from the Operand 

Access table and third-party editors such as Excel. 

Note ♦ The Paste destination within Operand Access must be large enough to 
hold the Clipboard contents. Clipboard contents are pasted to the right and down.  
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 Export/Import Operand values to/from an Excel spreadsheet customized to 

Unitronics' PLC Data Types. 

Within Excel, values can be edited,  imported to Operand Access, then written to 
the controller 

 
To export real-time values from the PLC to Excel:  

1. Create a region containing the operand values you wish to export. 
2. Select Read Regions in order to update those values,. 
3. Select Export to Excel. 

Note ♦  Not all operand values are updated with real-time values when you run On 
Line mode. When you run On Line mode, only the values that are displayed within 
the Operand Access window are updated. Operands that are not displayed in the 
Operand Access window during On Line are not updated.  

Therefore, running On Line mode immediately before Export to Excel does not 
guarantee the export of all updated operand values.   
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M90 Downloader 
M90 Downloader enables you to install control applications in local or remote M90/91 
controllers. These applications are in .d90 format.  

The utility is located on the Tools menu. 

 

 

To download files: 

1. Select a work mode. The Network definitions are set in the Remote Access PC Com 
Parameters (non-modem) 

2. Click Select File; the Select file box opens. 
3. Navigate to the desired.d90 file, then click Download to install the application in the 

controller. 
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Information Mode 
Information Mode is a utility that is embedded in the operating system of the controller. Via 
Information Mode, you can view data on the LCD screen, use the controller’s keyboard to 
directly edit data, and perform certain actions such as resetting the controller.  You can 
enter Information Mode at any time without regard to what is currently displayed on the 
LCD screen. 

Enter Information Mode by pressing the <i> key for a few seconds.  The default password is 
1111. 

 

Viewing data does not 
affect the controller’s 
program.  Performing 
actions, such as 
initializing the 
controller, can 
influence the program. 
 
Note ♦ When you 
use Information Mode, 
the keyboard is 
dedicated to that 
purpose. The keys 
return to normal 
application functions 
when you exit 
Information Mode. 

Using Information Mode 
1. To enter Information mode, press the <i>button on the Vision’s keyboard.   
2. Enter your password.  The default password is 1111.  This password remains in 

effect until you change it via the Information Mode screen described in the table 
below.   

3. The controller enters Information Mode, showing the first category, Data Types.   

 

The controller will block entry 
into Information mode until the 
correct password has been 
entered.  This is why you must 
record any password you set 
for your controller. 

The data in Information Mode 
is arranged in Categories. 
 Each Category contains 
several Subjects. You 
navigate Information Mode by 
using the keyboard buttons. 

To exit Information mode, 
press the <ESC>button on the 
Vision’s keyboard.  Each 
press returns one level up. 
Press the number of times 
necessary to exit.   

Note ♦ When you reenter Information Mode, the controller will return to the last Category 
viewed. 
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The table below shows the categories of information that can be accessed in this mode. 

Category  Subject  Possible Actions 

Data  Types   Memory  B i ts  •  V iew b i t  s ta tus  

Sys tem B i ts  •  Change  b i t  s ta tus  (Se t /Rese t )  

Memory  In tegers  
 
Sys tem In tegers   
 
Memory  Longs  
 
Sys tem Longs  
 
Memory  Doub le  
Words  
 
Sys tem Doub le  
Words  

•  V iew in teger / l ong  in teger /doub le  word  va lue .  
 

•  Change  va lues  
 

•  Togg le  Base :  v iew the  va lue  in  dec ima l  o r  
hexadec ima l  fo rm.  

Inpu ts   •  V iew inpu t  s ta tus . ·   
•  Force  inpu t  s ta tus  to  1  (FR1)  o r   0  (FR0) .  

 Fo rced va lues  s tay  i n  e f fec t  un t i l  Norma l  mode 
(NRM)  i s  se lec ted ,  o r  un t i l  t he  con t ro l l e r  i s  
i n i t i a l i zed  o r  rese t .    
Note  ♦  Fo rced  va lues  do  in f l uence your  
p rog ram.   Th is  can  be  use fu l  i n  tes t i ng  the  
e f fec t  o f  an  inpu t  cond i t i on  on  an  ou tpu t  
s ta tus .  

Ou tpu ts   •  V iew ou tpu t  s ta tus . ·  
•   Fo rce  ou tpu t  s ta tus  to  1  (FR1)  o r   0  (FR0) .  

 No te  tha t  fo rced  ou tpu t  va lues  do  no t  a f fec t  
your  p rog ram.  

•   Se t /Rese t  ou tpu t  s ta tus .  

 

T imers   •  En te r  a  P rese t  T imer  va lue .   
•  V iew the  cu r ren t  t imer  va lue  and  s ta tus  by  

se lec t ing  the  R .T .  op t ion .  

Sys tem  Mode l  &  O/S  Ver  •  Check  the  con t ro l l e r ’ s  mode l  number  and  
opera t ing  sys tem ve rs ion .   

•  Check  whe ther  the  cont ro l l e r  i s  i n  Run o r  S top  
mode .  

 Work ing  Mode  •  Check  whe ther  the  cont ro l l e r  i s  i n  Run o r  S top  
mode .  

•  Rese t  the  con t ro l l e r .  Th is  res ta r ts  your  
p rog ram;  res to r ing  power -up  va lues  to  a l l  da ta  
t ypes  excep t  fo r  those p ro tec ted  by  the  ba t te ry  
memory  backup .  

•  In i t i a l i ze  the  con t ro l l e r .  Th is  res ta r ts  your  
p rog ram and  in i t i a l i zes  a l l  va lues ,  res to r ing  0  
va lues  to  a l l  da ta  t ypes .  

 T ime  &  Date   •  V iew the  Rea l  T ime  C lock  (RTC)  se t t i ngs .  
 No te  tha t  the  RTC se t t i ngs  con t ro l  a l l  t ime-
based func t i ons .   

•  Change  the  RTC se t t i ngs  v ia  the  con t ro l l e r ’ s  
keyboard .  

 Un i t  ID  The  Un i t  ID  number  iden t i f i es  a  ne tworked  con t ro l l e r .  
You  can :   

•  Change  the  ID  number .   The  new ID  number  
w i l l  remain  i n  e f fec t  un t i l  the  con t ro l l e r  i s  
rese t .   

•  Burn  the  ID number  i n to  the  con t ro l l e r ’ s  FLASH 
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memory .  Th is  i s  a  pe rmanen t  change .  

 Ser ia l  Por t  1  
Ser ia l  Por t  2  

•  V iew and  ed i t  communica t ion  se t t i ngs .   
•  Se lec t  to  Change  o r  Burn  the  new se t t i ngs .  

 CANbus  Baud  Ra te  •  Change  the  CANbus  baud  ra te .  

Func t i on  
B lock  

Reserved  fo r  
fu tu re  use   

 

Password  New  Se t  a  New Password  

Hardware  
Con f igu ra t ion  

 •  Check  i f  I /O  Expans ion  Modu les  a re  i ns ta l l ed .  
 No te  tha t  I /O  Expans ion  Modu les  a re  
rep resented  by  le t te rs .   I den t i ca l  modu le  t ypes  
a re  rep resen ted  by  iden t i ca l  l e t te rs  as  shown 
be low.   

•  Shows  i f  an  I /O  modu le  i s  shor t -c i r cu i ted .  
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